
This month’s newsletter looks at formatting – specifically for numbers, charts 
and comments, the latter an oft neglected area of spreadsheeting. If you think you need more information, why 
not consider one of our training courses to brush up on these tips? There’s discounts to be had (see below). 
It’s good to see reader’s questions coming in, by the way – we will always try to respond to your technical, 
training and consulting queries. 
See you next month. 

Custom Number Formatting
Given that one of the primary purposes of a spreadsheet is to present numerical data, it is important how numerical data is presented.  
Cells may be individually formatted, using CTRL + 1 (all versions of Excel):

Formatting only changes the appearance, not the underlying value, of 
a cell. For example, if cells A1 and B1 had the number ‘1.4’ typed in but 
were formatted to zero decimal places, then if cell C1 = A1 + B1, you 
would truly have 1 + 1 = 3 (well, 1.4 + 1.4 = 2.8 anyway).

This should not be confused with ‘(Set) precision as displayed’ (Excel 
2007 and later: ALT + T + O -> Advanced -> When calculating this 
workbook -> Set precision as displayed; earlier Excel versions: Tools -> 
Options -> Calculation -> Workbook options -> Precision as displayed). 
Selecting this option and clicking ‘OK’ will permanently change stored 
values in cells to whatever format has been selected, including the 
number of decimal places (e.g. 15.75 formatted to one decimal placed 
would become precisely 15.8).

Excel has many built-in number formats that are fairly easy to 
understand, e.g. Currency, Date, Percentage. The default format is 

‘General’ where Excel will endeavour to provide the most appropriate 
format for the contents. For example, typing ‘3 3/4’ into a cell will 
result in Excel selecting a mixed format.

But what do you do if you can’t find an appropriate format?

Selecting the ‘Custom’ category activates the ‘Type’ input box and 
allows between 200 and 250 custom number formats in a particular 
workbook, depending upon the language version of Excel that has been 
installed.

The ‘Type’ input box allows up to four aspects of formatting to be 
specified in a cell. These aspects are referred to as sections and are 
separated by a semi-colon (;). To ascertain what is contained in each 
section depends on the total number of sections used, viz.
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No. of Sections	 Section Details (assuming no conditions)

1 (min)	 All numerical values

2	 Non-negative Numbers; Negative Numbers

3	 Positive Numbers; Negative Numbers; Zero Values

4 (max)	 Positive Numbers; Negative Numbers; Zero Values; Text

To the uninitiated, coding custom number formats may appear incomprehensible. However, understanding the following tables from Microsoft® 
soon puts things into perspective.

Number Code	 Description

General	 General number format

0	 Digit placeholder (if no number, a ‘0’ will be used to ‘pad’)

#	 Digit placeholder (does not display extra zeros)

?	 Digit placeholder (leaves space for extra zeros, but does not display them)

. (decimal point / full stop)	 Decimal point!

%	 Percentage displayed

, (comma)	 Thousands separator

/	 Used to delineate numerator from denominator in Fraction category

E+ e+ E- e-	 Scientific notation

Text Code	 Description

$ - + / ( ) : space	 These characters are displayed in the number.

“text”	 For other characters, in order to ensure Excel does not misinterpret them, it is best to use enclose the 	
		  character(s) in quotation marks…

\character	 …or precede it with a backslash

*	 Repeats the next character in the format to fill the column width. Only one asterisk per section of a 	
		  format is allowed

_character	 Skips the width of the next character. In particular, this syntax is often used with the closing parenthesis,  
		  _), in a positive number format (when the negative format includes brackets). This allows the values 
		  to line up at the decimal point

@	 Text placeholder

Date Code	 Description

m	 Month as a number without leading zeros (1 to 12)

mm	 Month as a number with leading zeros (01 to 12)

mmm	 Month as an abbreviation (Jan – Dec)

mmmm	 Unabbreviated month (January – December)

mmmmm	 First letter of month (J, F, M, A, M, J, J, A, S, O, N, D)

d	 Day without leading zeros (1 to 31)

dd	 Day with leading zeros (01 to 31)

ddd	 Week day as an abbreviation (Sun – Sat)

dddd	 Unabbreviated week day (Sunday – Saturday)

y or yy	 Year as a two digit number (e.g. 09, 97)

yyy or yyyy	 Year as a four digit number (e.g. 2009, 1997)
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Time Code	 Description

h	 Hours as a number without leading zero (0 to 23)

hh	 Hours as a number with leading zero (00 to 23)

m	 Minutes as a number without leading zero (0 to 59)

mm	 Minutes as a number with leading zero (00 to 59)

s	 Seconds as a number without leading zero (0 to 59)

ss	 Seconds as a number with leading zero (00 to 59)

[h]	 With times only, will increment hours to 24 and beyond

[m]	 With times only, will increment minutes to 60 and beyond

[s]	 With times only, will increment seconds to 60 and beyond

AM/PM am/pm	 Time based on the 12-hour clock [24-hour clock is the default]

Miscellaneous Code	 Description

[Black], [Blue], [Cyan], [Green]	 Displays the characters in the specified colours 
[Magenta], [Red], [White], [Yellow]

[Color n]	 Displays the characters in a specified colour, where n is a value from 1 to 56, and refers to the nth colour  
		  in the color palette

;		 Delineates a section

[Condition Value]	 Condition may be any one of the comparison operators, <, >, =, <=, >=, <> and Value may be any number. 
		  A number format may contain up to two conditions

For more on number formatting, illustrative examples and to download a free sample Excel workbook, please go to  
http://www.sumproduct.com/thought/number-formatting.

Training Update

Things have been moving apace in our Training Division. With our 
various partners around the globe, we have added several new training 
courses to the rota, including courses on Budgeting and Forecasting, 
Power Pivot, Project Finance Modelling and Valuation Modelling, 
amongst others. We will be updating our training brochure in due course 
(watch this space), but in light of our success, we’d like to announce a 

special offer on in-house training courses in January – we’re offering 
a whopping 20% discount off our usual rates for bookings made and 
purchased before Friday 13 December. This covers both standard and 
tailored training courses.

Email training@sumproduct.com for further information and to make 
a booking.
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Reader’s Question
I have been working with an Excel spreadsheet for some time and suddenly the graphs in this file have disappeared. I can’t put new charts in – the 
relevant parts of the Ribbon are greyed out. How do I get the chart functionality back?

Answer: This sounds like a clear case of objects being hidden – go to Excel’s Options (ALT + T + O in all versions of Excel), then go to ‘Advanced’ 
section in left-hand column, scroll down to ‘Display options for this workbook’ (NOT ‘Display’) and then change the final setting, ‘For objects show’ 
to ‘All’ rather than ‘Nothing (hide objects)’.

Final Comment
Most of us use Comments from time to time (Excel 2003 and earlier: Insert -> Comment, Excel 2007 and late: Review Tab, New Comment, all versions: 
SHIFT + F2). However, we’re frequently quite boring regarding how we format them:

We can soon jazz it up though. To do this, first create the comment and then select the comment itself, viz.

Get Back in the Box
Regular readers are probably getting rather bored with our running commentary on the trials and 
tribulations of picking up a copy of Power Pivot via the purchase of the Excel 2013 Standalone 
package.

However, we have it on good authority now (i.e. from Microsoft) that the Excel 2013 Standalone SKU 
should now include the eagerly anticipated Business Intelligence add-ins when installed, although 
it may require an uninstallation / reinstallation of Office in order for Power Pivot to appear in the 
COM add-ins. However, for the resilient amongst you, if you do indeed complete the Microsoft Trial 
of Fire, you should come out the other end with Power Pivot and other assorted BI goodies.

Upcoming SumProduct training courses

Singapore 26th - 29th Nov: Strategic Planning, Budgeting and 
Forecasting

Sydney 13th - 14th Jan 2014: Financial Modelling 101

Melbourne 15th - 16th Jan 2014: Financial Modelling 101

Sydney 3rd - 4th Feb 2014: Power of Power Pivot

Brisbane 5th - 6th Feb 2014: Power of Power Pivot

Melbourne 10th - 11th Feb 2014: Power of Power Pivot

Hong Kong 10th - 13th Jun 2014: Strategic Planning, Forecasting 
and Budgeting

Perth 21st - 22nd Jul 2014: Financial Modelling Fundamentals

Singapore 18th No v- 21st Nov: Strategic Planning, Forecasting 
and Budgeting
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Next, you need to locate the “Change Shape” tool. For Excel 2007 onwards, this can be placed in the Quick Access toolbar (otherwise, for Excel 2003 
and earlier, View -> Toolbars -> Drawing -> Draw -> Menu -> Change AutoShape):

When the comment is selected by the border, click the Change Shape tool:

From that, you can select basic shapes, block arrows, flowcharts, stars and banners, or callouts, each of which has yet another set of shapes to choose from.	
	

Once you have the new shape, right-click the border once again, and choose ‘Format Comment...’ as shown, if you wish to format this comment 
even further:
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That will bring up yet another dialog, from which you can choose Fill effects:

From this dialog box you can even select the Picture tab and import a picture:

OK – so this looks terrible – but you know what we mean!!
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Registered Address: SumProduct Pty Ltd, Level 1, 6 Riverside Quay, Southbank VIC 3006
Melbourne Address: SumProduct Pty Ltd, Level 9, 440 Collins Street, Melbourne VIC 3000

Please forward
These newsletters are not intended 
to be closely guarded secrets. Please 
feel free to forward this newsletter to 
anyone you think might be interested.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management

If you require modelling assistance 
of any kind, please do not hesitate to 
contact us at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Email us at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in our 
training brochure:

Key Strokes

Keystroke What it does
CTRL + ( Hide row

CTRL + ) Hide column

CTRL + SHIFT + ( Unhide row

CTRL + SHIFT + ) Unhide column (but only in Excel 2007 and earlier versions!)

Each newsletter, we’d like to introduce you to several useful keystrokes you may or may not be aware of. This month we look at an 
interesting anomaly – Excel 2010 and later versions have destroyed the following elegant symmetry…

Actually for ‘(‘ and ‘)’ use the numbers ‘9’ and ‘0’ respectively, but we think it makes more sense expressed as it is in the table (above). 
Petition your local Microsoft rep to unhide columns once more!!

There are over 540 keyboard shortcuts in Excel. For a comprehensive list, please download our Excel file at  
http://www.sumproduct.com/thought/keyboard-shortcuts.

New Services Offered
Apologies to our overseas readers and clients, but we’d like to perform a domestic plug!  
Although SumProduct works worldwide with our clients large and small, we have had a 
recent spate of requests for accounting and taxation services / queries back here in Oz. 
Never ones to look the proverbial gift horse in the mouth, we have decided to take action.

So, with no further ado, we’d like to take this opportunity to welcome Bernadette Crennan 
to the SumProduct fold, who will specifically address these niche queries and work requests.  
With over 30 years’ experience, Bernadette is a chartered accountant and registered tax 
agent, who will be responsible for our domestic work in the preparation of financial accounts 
and income tax returns, Business Activity Statements and other compliance requirements.  
In particular, Bernadette is highly skilled / experienced in income tax consulting, dealing 
with the simple structure questions to the more complicated issues around small business 
concessions for capital gains tax, structures and negotiations with the Australian Taxation 
Office (e.g. negotiation of payment arrangements, lodgements, book-keeping, remission of 
penalties and interest, extension of time to lodge returns and other issues as they arise).

For queries in these areas specifically please feel free to contact Bernadette directly at 
bernadette.crennan@sumproduct.com.


